
 � Estimated Time: 
2 hours

n	 OBJECTIVES
Upon completion of this lesson, you should be able to:

n	 Delete and insert text using the Backspace and Delete keys and 
Insert and Overtype modes.

n	 Undo, redo, and repeat actions.

n	 Edit text using drag-and-drop editing and the Cut, Copy, and 
Paste commands.

n	 Use proofing tools to check and correct spelling and grammar and 
use research services.

n	 Format characters with fonts and attributes.

n	 Format paragraphs with fonts, line spacing, alignment, tabs and 
indents, and bulleted and numbered lists.

n	 Format documents with margin settings, page orientation settings, 
and page breaks.

n	 Find and replace text.

n	 Data Files
To complete this lesson, you will need these data files:

Step8-1.docx		  Step8-12.docx

Step8-4.docx		  Step8-13.docx

Step8-7.docx		  Project8-1.docx

Step8-9.docx		  Project8-2.docx

Step8-10.docx

Lesson 8

Editing and Formatting 
Documents

n	 VOCABULARY
alignment

Clipboard

drag-and-drop editing

edit

first line indent

font

format

Format Painter

hanging indent

indent

Insert mode

landscape orientation

manual line break

manual page break

margin

Overtype mode

points

portrait orientation

select

soft page break
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	 Module 2  Key Applications

Word provides many features that give you the ability to improve and enhance 
your documents. Editing and formatting features give you the ability to refine your 
documents and determine how they will look on the screen, on the Web, or as  
printed pages.

Editing Documents
When you edit a document, you modify or adapt the document and make revisions or 
corrections. Editing a document involves adding, deleting, changing, or moving text, 
and Word provides many features that enable you to make changes, correct errors, 
and check the spelling and the grammar in your document.

Selecting Text
When you select text, you identify a block of text you want to edit. The text can be a 
single character, several characters, a word, a sentence, one or more paragraphs, or 
even the entire document. Once you select text, you can delete it, replace it, change 
its appearance, move it, copy it, and so on. You can use the mouse or the keyboard 
to select text. The quickest way to select text using the mouse is to click and hold 
the mouse button, drag the mouse pointer over the desired text, and then release the 
mouse button.

Sometimes it is difficult to select precisely when you are dragging the mouse. 
Table 8–1 lists several options for selecting text using the mouse and the keyboard. 
To deselect the text (remove the selection), click anywhere in the document window 
or press an arrow key. If you accidentally delete or replace selected text, or if you just 
change your mind, click the Undo button.

◗  Vocabulary
edit

select

Heads up

Be cautious when working with 
selected text. If you press any let-
ters, numbers, or symbols on the 
keyboard when text is selected, 
the new keystrokes will replace the 
selected text. Pages of text can 
accidentally be replaced with a 
single character.

2-1.1.7
2-1.3.2
2-1.3.3
2-1.3.5
2-2.2.1
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Lesson 8  Editing and Formatting Documents	

Step-by-Step 8.1
	 1.	 Start the Word application.

	 2.	 Open Step8-1 from the data files and save the document as 

Carbohydrates1.

	 3.	 If necessary, click the Show/Hide ¶ button to show the nonprinting 

characters.

to select do this:

Any amount of text Click and hold the mouse button, drag the pointer over the text, then 
release the mouse button

A word Double-click the word

A sentence With no other text or objects selected, press and hold Ctrl, then click 
anywhere in the sentence

A paragraph Triple-click anywhere in the paragraph, or double-click in the left 
margin

An entire document Press Ctrl+A; or move the pointer to the left of any text, and when 
the pointer changes to a right-pointing arrow, triple-click

A line Click in the left margin

Multiple lines Click and hold the mouse button, and drag the pointer in the left 
margin

One or more characters to the right Press and hold Shift and press the right arrow

One or more characters to the left Press and hold Shift and press the left arrow

To the beginning of a word Press and hold Ctrl+Shift and press the left arrow

To the end of a word Press and hold Ctrl+Shift and press the right arrow

Any amount of text Click where you want the selection to begin, press and hold Shift, 
and then click where you want the selection to end; everything 
between the two clicks is selected

or

Position the insertion point where you want the selection to begin, 
press F8 to toggle on the select mode, then use the arrow keys or the 
mouse to indicate where you want the selection to end (If you don’t 
execute a command such as Delete or applying a format, press the 
Escape key to toggle the selected mode off)

Table 8–1  Ways to select text
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	 4.	 Move the I-beam mouse pointer until it is at the beginning of the first 

line of text. Click and hold the mouse button and drag the pointer 

through the first sentence of text. When the whole first sentence is 

selected, release the mouse button. The sentence is now selected, as 

shown in Figure 8–1.

Selected
text

	 5.	 Double-click the word diet in the last paragraph to select it.

	 6.	 Press Ctrl+A to select the entire document. Click anywhere in the docu-

ment window to deselect the text.

	 7.	 Click to position the insertion point at the beginning of the second 

paragraph. Press and hold the Shift key, and then click after the word 

rice. Everything between the two clicks is selected.

	 8.	 Continue to hold the Shift key and press the right arrow key to extend 

the selection. Press the left arrow key to reverse direction of the selec-

tion. Continue to press the left arrow key until text in the previous para-

graph is selected. Press the down and up arrow keys to reverse and 

extend the direction of the selection. Release the Shift key.

	 9.	 Position the insertion point at the end of the first paragraph. The inser-

tion point will appear between the period and the paragraph marker. 

Press and hold the Ctrl and Shift keys and then press the Home key. All 

of the text from the insertion point to the beginning of the document is 

selected.

	10.	 Click anywhere in the document window to deselect the text. Practice 

other methods of selecting text following the instructions in Table 8–1.

	11.	 Leave the document open.

Figure 8–1 
Selected text
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Deleting and Inserting Characters
Editing often involves deleting and replacing existing text. You can quickly delete 
characters one at a time by using either the Backspace or Delete key. The Backspace 
key deletes the character to the left of the insertion point. The Delete key removes 
the character to the right of the insertion point. When you hold down either of these 
keys, the characters will continue to be deleted until you release the key. You can 
also select characters, words, sentences, or paragraphs and then press the Delete or 
Backspace key to delete the selected text.

By default, Word enters text in a document using the Insert mode. In Insert 
mode, when you enter new text in front of existing text, the existing text shifts to 
the right to make room for the new text. When the Insert mode is turned off, the 
Overtype mode is activated. In Overtype mode, new text replaces the existing text. 
You can change the settings for Insert mode and Overtype mode in the Word Options 
dialog box.

◗  Vocabulary
Insert mode

Overtype mode

Technology timeline

Typewriter Fonts
Before computers and word-processing programs, typewriters were used to create formal documents. The 
first machines typed only in capital letters. The Remington Company was the first to offer a typewriter that 
could print both upper- and lowercase letters with the addition of the Shift key. The action was called a  
shift because the carriage on a typewriter would actually shift the position of the typebar to print either of 
two letter cases. Modern electronic machines such as computers no longer use a mechanical shift to print 
upper- and lowercase letters, but the Shift key remains on keyboards for this process.

When using typewriters, it was also common practice to include two blank spaces between sentences. 
The typewriters used a monospace typeface, which means all characters were the exact same width. For 
example, the amount of horizontal space provided for the letter i was the same as the amount of horizontal 
space for the letter m. The extra blank space created more blank space and made it easier to see the break 
between sentences. Today’s word-processing applications are more sophisticated, and the extra spaces are 
not necessary because the fonts generally allow for proportional spacing, which eliminates excess blank 
space between characters. The blank space between sentences is more obvious so you need only enter one 
blank space between sentences. In spite of this, monospace fonts have not vanished. They are especially 
useful when aligning text in columns.
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	 Module 2  Key Applications

Step-by-Step 8.2
	 1.	 If necessary, open Carbohydrates1 from your solution files.

	 2.	 Position the insertion point right before the period at the end of the 

last sentence in the second paragraph. Press the Backspace key several 

times to erase the last four words in the sentence (instead of losing 

weight).

	 3.	 Move the insertion point to the beginning of the word complex in the 

second paragraph. Press Delete to remove the first letter of the word. 

Double-click the remaining part of the word to select it, and then press 

Delete.

	 4.	 Double-click the word carbohydrates in the last paragraph to select it, 

and enter fat. The selected text is replaced with the new text.

	 5.	 Double-click the second occurrence of the word fat in the last paragraph 

and enter complex carbohydrates.

	 6.	 Make sure the Insert mode is activated. Click the Office Button, click 

Word Options, and then click Advanced. Under Editing options, make 

sure there is no check mark for the option Use Overtype mode. Also, 

if necessary, enable the option Use the Insert key to control Overtype 

mode. Compare your screen to Figure 8–2.
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Settings
should look
like this

	 7.	 Click OK to accept any changes and close the Word Options dialog box.

	 8.	 Position the insertion point right before the first occurrence of the word 

and in the first sentence of the second paragraph. Enter bread, and 

then a space. Because you are in Insert mode, Word inserts the text 

between the existing characters.

	 9.	 Press Insert to toggle on Overtype mode.

	10.	 Position the insertion point in front of the word five in the first sentence 

of the third paragraph. Enter four. The new text replaces the word five.

	11.	 Press Insert to toggle to Insert mode.

	12.	 Save the changes and leave the document open. You must complete 

Step-by-Step 8.3 before closing the document.

Undoing, Redoing, and Repeating
Sometimes you may delete or replace text unintentionally. Whenever you perform 
an action that you want to reverse, you can use the Undo command. If you undo 
an action and then change your mind, you can reverse the undo action by using the 
Redo command. You can even undo and redo multiple actions at one time.

Figure 8–2 
The Insert/Overtype 
mode options
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	 Module 2  Key Applications

There may be times when you want to repeat your last action. For example, you 
may enter new text in a document and then want to add the same text in other loca-
tions in the document. You can use the Repeat command to repeat your last action. 
The Undo, Redo, and Repeat buttons can be accessed on the Quick Access Toolbar, 
shown in Figure 8–3. The Redo button exchanges with the Repeat button on the 
Quick Access Toolbar when you undo an action.

Undo button Redo button

Undo button
list arrow

The Redo button
changes to the
Repeat button

Figure 8–3  �The Undo, Redo, and Repeat buttons on the Quick Access 
Toolbar

ScreenTips for these buttons are conditional and will reflect your recent action. 
Sometimes an action cannot be reversed, and the ScreenTip for the Undo button 
changes to “Can’t Undo.” If you can’t repeat the last action, the Repeat button will 
be dimmed and the ScreenTip for the Repeat button will show “Can’t Repeat.” 

Step-by-Step 8.3
	 1.	 The document Carbohydrates1 should already be open from the previous 

Step-by-Step. Save the document Carbohydrates1 as Carbohydrates2.

	 2.	 Position the insertion point at the end of the document. Enter your 

name, and then press Enter twice.

	 3.	 Move the insertion point to the beginning of the document.

	 4.	 Position the mouse pointer over the Repeat button  on the Quick 

Access Toolbar to show the ScreenTip Repeat Typing (Ctrl + Y). Then, 

click the Repeat button. Your name and a blank line are inserted at the 

position of the insertion point.

	 5.	 You change your mind. Position the mouse pointer over the Undo 

button  on the Quick Access Toolbar to show the ScreenTip Undo 

Typing (Ctrl + Z). Then, click the Undo button. Your name and the blank 

line are removed from the top of the document.

	 6.	 Click the Undo button arrow and position the mouse pointer over Typing 

“bread,”. All the previous actions above that action in the list will also 

be highlighted, as shown in Figure 8–4. Click Typing “bread,”. The last 

six actions are reversed.
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Lesson 8  Editing and Formatting Documents	

	 7.	 Click the Redo button  on the Quick Access Toolbar to reverse only 

the last undo. The word bread is reinserted in the second paragraph.

	 8.	 Click the Redo button four more times to replace the word five with four.

	 9.	 Click the Undo button arrow. The list includes Typing “bread,” and 

Typing the letters f, o, u, and r.

	10.	 Click anywhere in the document window to close the Undo list. Save the 

changes and leave the document open.

Copying and Moving Text
Selected text can be copied or moved within a document and between documents. 
For example, you can copy text from an e-mail message to a Word document. There 
are several ways to copy and move text.

Using Drag-and-Drop Editing
When you use the mouse to drag selected text from the existing location and  
then drop the selected text in a new location, it is called drag-and-drop editing. 
Drag-and-drop editing makes moving text quick and easy, especially when you are 
moving the text short distances. You simply drag selected text to the new location and 
then release the mouse button. You can also copy text using drag-and-drop editing. 
Hold down Ctrl as you drag, and the selected text will be copied instead of moved.

Using the Cut, Copy, and Paste Commands
You can also use the Cut, Copy, and Paste commands to move and copy selected text. 
When you use the Cut, Copy, and Paste commands, Word stores the selected text 
on the Clipboard. The Clipboard is a temporary storage place in your computer’s 
memory, and it is shared among all the Office applications. You send selected 
contents of your document to the Clipboard by using the Cut or Copy commands. 
The Clipboard stores up to 24 items, which you can view by showing the Clipboard 
task pane. If you prefer, you can work with the Clipboard task pane open.

Figure 8–4 
Select multiple actions in  
the Undo list box

◗  Vocabulary
drag-and-drop editing

Clipboard

Extra for Experts

Word offers many options for 
using the Clipboard. Use the Help 
feature to find out more about the 
Clipboard and to determine which 
options best meet your needs.
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	 Module 2  Key Applications

The Clipboard can store data of all Office types, and that data can be inserted 
into the same document, into other documents in the same application, or into files 
in other Office programs. You can retrieve the contents of the Clipboard by using the 
Paste command. You can select any one of the items on the Clipboard and paste it, or 
you can paste all of the items at once. Pasting the contents of the Clipboard does not 
delete the contents from the Clipboard. Therefore, you can paste Clipboard items as 
many times as you want. However, when you turn off the computer, the Clipboard 
contents are erased.

Step-by-Step 8.4
	 1.	 If necessary, open Carbohydrates2 from your solution files. Save the 

document Carbohydrates2 as Carbohydrates3. Also, if necessary, click 

the Show/Hide ¶ button to show the nonprinting characters.

	 2.	 Select all of the text in the third paragraph, but do not include the 

paragraph marker in the selection.

	 3.	 Point to the selection and hold down the left mouse button. Drag the 

insertion point to the end of the first paragraph, and then release. If you 

look closely as you drag the selected text, you will see that the insertion 

point changes to a dotted vertical line. Word automatically adjusts the 

spacing by adding a blank space between the two sentences.

	 4.	 With the sentence still selected, press and hold Ctrl and use the left 

mouse button to drag the text to the end of the document. Notice as you 

drag the text that the mouse pointer has changed and includes a plus 

sign. Release the mouse button. The text is copied to the new location.

	 5.	 Click the Undo button and then click anywhere in the document window 

to deselect the text.

	 6.	 Click the Dialog Box Launcher button in the Clipboard group on the 

Home tab to open the Clipboard task pane, as shown in Figure 8–5. 

Your Clipboard may show different items or no items at all. If items 

appear on the Clipboard, click the Clear All button to remove any items 

from the Clipboard.

Extra for Experts

To drag text beyond the current 
screen of text, drag the pointer 
toward the top or bottom of the 
screen. As you hold the pointer at 
the edge, the document will auto-
matically scroll in that direction.
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Click to clear
the contents on
the Clipboard

Click to close
the Clipboard
task pane

Click to launch
the Clipboard
task pane

Paste button

	 7.	 Press and hold Ctrl and click anywhere within the last sentence in the 

document to select the whole sentence. In the Clipboard group, click the 

Cut button . The selected text appears on the Clipboard. Cutting removes 

text from the document and stores it on the Clipboard.

	 8.	 Triple-click anywhere in the second paragraph in the document to select 

the whole paragraph. In the Clipboard group, click the Copy button . 

The selected text appears on the Clipboard. Copying stores the text or data 

on the Clipboard, but it leaves the text in the document.

	 9.	 Open Step8-4 from the data files. Press and hold Ctrl and press A to 

select the entire document, and click the Copy button. The text is stored 

on the Clipboard.

	10.	 Switch to the Carbohydrates3 document and position the insertion 

point at the beginning of the second paragraph. In the Clipboard group, 

click the Paste button. Word inserts the most recent item added to the 

Clipboard at the location of the insertion point. Notice that the copied 

text still appears on the Clipboard.

Heads up

You can also access the Cut, 
Copy, and Paste commands by 
right-clicking the selected text 
and choosing the desired com-
mand from the shortcut menu that 
appears. The keyboard shortcuts 
for Cut are Ctrl+X; for Copy, Ctrl+C; 
and for Paste, Ctrl+V.

Figure 8–5 
The Clipboard task pane with  
data items
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	11.	 Open a new blank document, and, if necessary, open the Clipboard task 

pane. There should be at least three items on the Clipboard. Click the 

Paste All button in the Clipboard pane. All the contents on the Clipboard 

are inserted at the location of the insertion point. The oldest item on the 

Clipboard is pasted first.

	12.	 Save the new document as Carbohydrates4 and then close the document. 

Also close the Step8-4 document. If prompted to save changes,  

click No.

	13.	 Position the insertion point at the end of the last sentence in the last 

paragraph. In the Clipboard task pane, click the item that begins So, 

if you want to lose weight. The text is inserted in the document at the 

location of the insertion point.

	14.	 Click the Close button in the upper-right corner of the Clipboard 

task pane to hide the pane. Save the changes to the Carbohydrates3 

document and then close the document.

Using the Proofing Tools
An accurate document makes a good impression. Word provides several proofing 
tools that will help you prepare an error-free document. Figure 8–6 shows the 
commands in the Proofing group on the Review tab.

Available
proofing tools

Figure 8–6  The Proofing group on the Review tab

Checking Spelling and Grammar
Checking the spelling in a document can significantly reduce the amount of time you 
spend proofreading. As you enter text, Word automatically checks the spelling of each 
word against its standard dictionary. If Word cannot find the word in its dictionary, 
it will underline the word with a wavy red line. This does not necessarily mean the 
word is misspelled. It simply means the word is not listed in Word’s dictionary. You 
can access a shortcut menu to view suggestions for changes.

Good proofreading skills also include checking grammar. When you check 
for the grammar in a document, you read for content and make sure each sentence 
makes sense. Word also automatically checks for grammar errors such as incomplete 
sentences, the wrong use of words, and capitalization and punctuation errors. Possible 
errors are identified with a wavy green line below a word, phrase, or sentence. You 
can access a shortcut menu to view suggestions for changes.

Heads up

The spelling and grammar check-
ers are helpful tools, but you 
still need to have a good working 
knowledge of English grammar and 
spelling. The spelling and gram-
mar checkers can identify a pos-
sible problem, but it’s up to you to 
decide if a change is necessary.
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Lesson 8  Editing and Formatting Documents	

The red or green underlines are only visible on your screen. They will not appear 
when you print the document.

Using AutoCorrect and AutoComplete
It is common for us to make the same spelling error over and over. For example, you 
may often enter hte instead of the. The AutoCorrect feature automatically corrects 
errors as you enter text, which saves editing time. The AutoComplete feature suggests 
the spelling for frequently used words and phrases. For example, as you begin to 
enter the day of the week or the month, AutoComplete will provide an option for 
completing the word for you.

Step-by-Step 8.5
	 1.	 Open a new blank document and enter the following text exactly as shown 

here: It is beleived. Watch the screen as you press Spacebar. Word will 

automatically correct the spelling and change the word to believed.

	 2.	 Complete the sentence by entering the potawatomi indians were originally 

part of the ancient tribe Anishinabe. and then press Enter. Notice that 

there are red wavy lines under the words potawatomi and Anishinabe. 

Word automatically corrected the capitalization of the word indians.

	 3.	 Save the document as Neighbors1.

	 4.	 Point to the word potawatomi and right-click. A shortcut menu appears 

and shows two alternative spellings at the top of the menu. Click the first 

option Potawatomi in the shortcut menu, and the word in the document 

is corrected.

	 5.	 Right-click the word Anishinabe. The spelling you entered is correct, 

but this word is not included in the Word standard dictionary, so that is 

why the word is flagged. Click Ignore All in the shortcut menu. The red 

wavy line is removed, and the word Anishinabe will not be flagged as 

misspelled if entered again in this document.

	 6.	 Position the insertion point at the end of the document and enter In the 

early 1700s, lived near Green Bay, Wisconsin. and then press Enter. 

The entire sentence is underlined with a green wavy line.

	 7.	 Point to any part of the green underlined sentence and right-click. A 

shortcut menu appears, and the words Fragment (consider revising) 

appear at the top of the menu. Click outside the shortcut menu to close 

it. Position the insertion point in front of the word lived and enter they. 

The green wavy line disappears.

	 8.	 Save the changes and leave the document open.

Extra for Experts

If you prefer not to have Word 
check for spelling or grammar 
errors as you enter text in a docu-
ment, you can turn off this feature. 
Open the Word Options dialog box, 
click Proofing, and uncheck the 
options Check spelling as you type 
and Check grammar with spelling.

Heads up

If you want assistance correcting 
the grammar, click About This 
Sentence in the shortcut menu. A 
Word Help screen will open with 
suggestions for corrections.
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Using the Research Tools
Creating a report often requires research. As you write a report, you may struggle 
to think of the appropriate word or phrase to make the content easier for the reader 
to understand. Or, you may want to use a synonym to avoid overusing a word. The 
commands in the Proofing group on the Review tab provide you quick access to 
several resources including dictionaries, a thesaurus, encyclopedia articles, translation 
services, and research Web sites.

Counting the Words
How many times have you counted the words in an essay to confirm it meets the 
minimum or maximum requirement for total words? The Word Count command 
provides statistics about your document that include the number of pages, sentences, 
lines, and characters as well as how many words are in your document. You can see 
the current number of words in the document in the status bar at the bottom of the 
window.

Step-by-Step 8.6
	 1.	 If necessary, open Neighbors1 from your solution files. Save the docu-

ment Neighbors1 as Neighbors2.

	 2.	 Position the insertion point anywhere within the word near in the 

last sentence. Click the Review tab, and, in the Proofing group, click 

the Thesaurus button . The Research task pane, shown in 

Figure 8–7, appears, showing a list of synonyms for the word near.

Click here
for options

Heads up

When working offline, the only ser-
vices accessible in the Research 
task pane are the thesaurus and 
the bilingual dictionary that is 
installed with Office.

Figure 8–7 
The Research task pane with 
results for a Thesaurus search
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	 3.	 In the Thesaurus list, point to close to, as shown in Figure 8–7, and 

then click the list arrow. Click Insert. The word near in the document is 

replaced with close to.

	 4.	 In the Proofing group, click the Translate button . The Research 

task pane will change and show the translation options. The Search for 

box will most likely show Green because the insertion point is closest to 

the word Green. The From box should show English (United States).

	 5.	 Click the list arrow in the To box and then click French (France).

	 6.	 Click the green arrow below Translate the whole document. When 

prompted to translate the whole document, click Yes.

	 7.	 A window will open in your browser. If necessary, launch your browser 

from the taskbar to show the translation text.

	 8.	 Select all of the translation text, right-click anywhere within the 

selection, and click Copy in the shortcut menu. The selected text is 

saved on the Clipboard.

	 9.	 Switch to the Neighbors2 document, position the insertion point at the 

end of the document, right-click, and click Paste in the shortcut menu. 

The translation text is inserted in the document.

	10.	 In the Search for box at the top of the Research pane, enter Potawatomi. 

Click the list arrow in the box directly below, and then click Encarta 

Encyclopedia: English (North America). Links for online Encarta 

Encyclopedia articles about Potawatomi Indians appear.

	11.	 In the Proofing group, click the Word Count button . The Word Count 

dialog box opens, revealing the statistics for the document. Close the 

Word Count dialog box.

	12.	 Save the changes, close the Research task pane, and then close the 

document. Also, close the browser.

Formatting Documents
When you format a document, you change the appearance of the text or of the whole 
document. The formats and design elements used in a document should be based on 
the purpose of the document and the needs of reader. Formats can be applied either 
before or after you enter text in your document.

Word offers a number of formats, including character formats, paragraph 
formats, and document formats.

n	 Text color and underline are examples of character formats. You can apply more 
than one character format at a time. For example, you can apply both color and 
underline formats to characters.

Heads up

To find synonyms for a phrase, 
select all the words in the phrase.

2-1.3.4
2-1.3.6
2-1.4.1
2-1.4.2
2-2.1.1
2-2.1.2
2-2.1.3
2-2.1.4
2-2.1.5
2-2.1.7

2-2.1.16

◗  Vocabulary
format
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n	 A paragraph format is applied to an entire paragraph and cannot be applied to 
only a portion of a paragraph. For example, you cannot single space part of a 
paragraph and double space the rest. Word defines a paragraph as any amount of 
text that ends with a paragraph marker. A paragraph marker is inserted by press-
ing the Enter key, which creates a manual line break.

n	 Document formats apply to an entire document. For example, margins and paper 
size are document formats. You can position the insertion point anywhere in a 
document to change the entire document format.

Applying Character Formats
Changing the character format can actually make a document easier to read. A font 
is the design of the typeface in your document. Fonts are available in a variety of 
styles and sizes, and you can use multiple fonts in one document. The size of the font 
is measured in points. The larger the point number, the larger the font size will be. 
You can quickly change the appearance of the font by using the command buttons in 
the Font group on the Home tab, as shown in Figure 8–8. When you open the Font 
dialog box, more font options are available, and you can make several font changes 
at one time.

Font formats

Figure 8–8  The Font group on the Home tab

Changing the character format can also set the tone for a document. Consider the 
purpose of the document when you apply these design elements. While formatting 
text in all caps can draw the reader’s attention, it can also send the wrong message. 
Some readers may feel you are yelling at them. Changing font styles and font colors 
may make the text look pretty or cool, but some formats may make it harder to read 
the text.

Step-by-Step 8.7
	 1.	 Open Step8-7 from the data files and save the document as H2O1.

	 2.	 Click the Page Layout tab. Click the Line Numbers button  

and click Continuous from the list of options. Line numbers will appear 

to the left of each line, which will make it easier to identify the lines of 

text in the document.

	 3.	 Select all of the text in line 1. Word is intuitive, and because you selected 

text, a semitransparent image of the Mini toolbar with common format-

ting commands appears above the selection. Your screen should look 

similar to Figure 8–9 . If you do not see the Mini toolbar, select the text 

again, and do not move the mouse pointer away from the selection.

◗  Vocabulary
manual line break

font

points

172

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight



Lesson 8  Editing and Formatting Documents	

Mini toolbar

	 4.	 Position the mouse pointer over the Mini toolbar, and the image will 

brighten. Click the Bold button  to apply the bold format. Move the 

mouse pointer away from the Mini toolbar, and it disappears.

	 5.	 Click the Home tab. Notice the Bold button is highlighted to indicate 

that the selected text is formatted bold. With the text still selected, click 

the Change Case button  in the Font group. Click UPPERCASE.

	 6.	 Select all of the text in line 2. Click the Bold button and the Italic 

button  on the Mini toolbar. Then click the Font Color button arrow 

 on the Mini toolbar and click a color.

	 7.	 Select all of the text in line 4. In the Font group on the Home tab, click 

the Underline button arrow  and then click the last option in the 

list (the wavy line). Click the Underline button to remove the format. 

Click the Underline button again. The wavy line underline option is 

applied because it is the last underline option used.

	 8.	 Select all of the text in lines 8 and 9. Click the Font button arrow 

 in the Font group to show the font options. Position 

the mouse pointer over one of the font options in the list to show a  

live preview of the new font in the document window, as shown in  

Figure 8–10. Position the mouse pointer over a different font option, 

and the live preview reflects the change in fonts. The text does not 

change, however, until you choose a new font style.

Live preview

Click to
scroll down
through list

Figure 8–10 
Live preview for  
 a font style

Figure 8–9 
The semitransparent  
image of the Mini toolbar

173

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight



	 Module 2  Key Applications

	 9.	 Scroll down the list of fonts and select Comic Sans MS. The text in 

the document changes, and the name of the new font appears in the  

Font box.

	10.	 With the text still selected, click the Font Size list arrow. The point sizes 

are listed in increments. Click 14. With the text still selected, click the 

Shrink Font button  in the Font group three times to decrease the 

size by three increments. Click the Grow Font button  in the Font 

group once. The point size increases by one increment and 11 appears 

in the Font Size box.

	11.	 Select the o after 72 in the same paragraph. Click the Superscript 

button  in the Font group. Select the number 2 in H2O in line 1. 

Click the Subscript button  in the Font group.

	12.	 Position the insertion point at the end of the document on line 14. 

Change the font size to 14 and enter www.H2OCove.net. Press Enter. 

A hyperlink format is automatically applied to the URL. Because this 

document will not be published on the Web, you do not need a hyperlink 

format. Right-click the hyperlink and click Remove Hyperlink in the 

shortcut menu.

	13.	 Select the text in line 12 and click the Text Highlight Color button arrow 

 in the Font Group. Click a color, and the highlight is applied to the 

selected text.

	14.	 Save the changes and leave the document open.

Applying Paragraph Formats
Changing the paragraph formats can also make the document more attractive and 
easier to read. Paragraph formats include adjusting the blank space between lines of 
text, aligning text, setting tabs and indents, and adding bullets and numbering. Most 
of the paragraph formats can be applied using the commands in the Paragraph group 
on the Home tab, shown in Figure 8–11.

Paragraph formats
Line
spacing
button

Figure 8–11  The Paragraph group on the Home tab

Heads up

To highlight multiple sections of 
text throughout the document, 
select the highlight color first. 
The pointer will change to show 
a highlighter pen, and then you 
can drag the pointer over text to 
apply the highlight. To toggle the 
highlight option off, click the Text 
Highlight Color button or press the 
Escape key.
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Lesson 8  Editing and Formatting Documents	

Changing the Line Spacing and Alignment
The default line spacing in Word is single spacing. When text is double-spaced, there 
is a blank line between each line of text, which makes it easier to read. Many reports 
are formatted with double line spacing. You can also adjust the spacing both before 
and after the paragraph, which is common in newsletters to help to save space on a 
page and/or to make a headline stand out.

Alignment refers to how text is positioned between the left and right margins. 
Text can be aligned in four different ways: left, center, right, or justified. The default 
setting is left alignment. Center alignment is often used for titles, headings, and 
invitations. Right alignment is often used in tables for dollar amounts and dates. You 
can quickly apply any of these alignments using the buttons in the Paragraph group 
on the Home tab.

Step-by-Step 8.8
	 1.	 If necessary, open H2O1 from your solution files. Save the document 

H2O1 as H2O2.

	 2.	 Select all of the text in the document, and then click the Line spacing 

button . Click the 2.0 line spacing option. All of the lines are now 

double-spaced. There are still 15 lines in the document, but there is 

more blank space between the lines.

	 3.	 With all of the text still selected, click the Line spacing button and then 

click 1.5. The spacing between lines is reduced to 1½ line spacing, and 

there is less blank space between each line of text.

	 4.	 Position the insertion point in line 14. Click the Line spacing button, 

and then click Add Space Before Paragraph. Extra blank space is added 

between lines 13 and 14.

	 5.	 With the insertion point positioned in line 14, click the Line spacing 

button again. The next to last option has changed. Click Remove Space 

Before Paragraph.

	 6.	 Position the insertion point in line 1. Click the Line spacing button, 

and then click Add Space After Paragraph at the bottom of the list of 

options. Extra blank space is added between lines 1 and 2.

	 7.	 Click the Dialog Box Launcher in the Paragraph group to open the 

Paragraph dialog box. Notice that under Spacing, the After box shows 

12 pt. Click the down arrow once to reduce the setting to 6 pt. Click OK 

to apply the change and close the dialog box. The space between lines 1 

and 2 is adjusted.

Heads up

The keyboard shortcuts for single 
spacing is Ctrl+1. For 1.5 spacing, 
the shortcut key combination is 
Ctrl+5; and for double spacing it 
is Ctrl+2.

◗  Vocabulary
alignment
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	 8.	 With the insertion point positioned in line 1, click the Center button 

in the Paragraph group. Select all the remaining lines in the document 

and then click the Center button. All the lines are centered horizontally 

on the page.

	 9.	 Position the insertion point in line 8, 9, or 10. Click the Justify button 

 in the Paragraph group. The text is aligned at both the left and right 

margins. Because all three lines are in the same paragraph, the format 

is applied to all three lines of text.

	10.	 Select all of the text in lines 12, 13, and 14. Click the Align Text Left 

button  to move the text back to the left margin. Click the Align Text 

Right button  to align the text at the right margin.

	11.	 Select all of the text in lines 1 and 2 and increase the font size to 18. 

Select all of the text in lines 4 through 14 and increase the font size 

to 14.

	12.	 Deselect the text. Save the changes and close the document.

Setting Tabs and Indents
Tabs are useful for indenting paragraphs and lining up columns of text. Word’s 
default tabs are set at every half inch. You can, however, set custom tabs at other 
locations. There are four alignment options and a vertical bar for tabs. Table 8–2 
describes each of the options.

Extra for Experts

If you want to set precise measure-
ments for tabs, click the Paragraph 
group Dialog Box Launcher, and 
then click Tabs to open the Tabs 
dialog box.

tab setting description

 Left tab This is the default tab style; when you begin to enter text at the tab, the text is aligned on 
the left and extends to the right 

 Center tab Text is aligned evenly on either side of the tab position

 Right tab Text is aligned on the right and extends to the left

 �Decimal tab Numbers with decimals are all aligned at the decimal point, and text aligns on either side 
of the tab; a decimal tab can be used to align numbers or text

 Bar tab This setting does not position the text, but a vertical bar appears in the paragraph at the 
tab position; if the tab is formatted for multiple paragraphs, the vertical bar appears in all 
the paragraphs to create a vertical line along the column of text or numbers

Table 8–2  Options for tabs
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Lesson 8  Editing and Formatting Documents	

The ruler, which is available from the Show/Hide group on the View tab, can be 
used to quickly set tabs, indents, and margins in your document. The ruler is also a 
handy reference to see the “true” size of your text and document.

An indent is a space inserted between the margin and where the line of text 
appears. You can indent text from the left margin, from the right margin, or from 
both the left and right margins. For example, to draw attention to specific paragraphs 
in a document, you can indent all the lines of the paragraph from the left and right 
margins. If you want the first line of paragraphs to be indented, you can format a 
first line indent. A first line indent makes a long document with several paragraphs 
easier to read because the reader can easily tell where a new paragraph begins. When 
creating a bibliography for a report, you need to format a hanging indent, where the 
first line of text begins at the left margin, and all other lines of the paragraph hang, or 
are indented, to the right of the first line.

Step-by-Step 8.9
	 1.	 Open Step8-9 from the data files and save the document as Parks. 

Show nonprinting characters and continuous line numbers.

	 2.	 Click the View tab and, if necessary, click the View Ruler check box 

 in the Show/Hide group. The ruler is visible when there is a 

check mark in the box.

	 3.	 Position the insertion point at the beginning of line 3. Press Tab three 

times. Although they do not appear on the ruler, default tabs are already 

set for every ½ inch. The three tab symbols are spaced every ½ inch.

	 4.	 Position the insertion point anywhere in line 4. Click the tab selector 

at the left end of the ruler until the Right Tab symbol  appears, as 

shown in Figure 8–12.

Right Indent
marker

Right
Tab symbol
positioned
at 5-inch
marker

Left Indent
marker

Click tab
selector to
change tab
type

Heads up

When you press Enter to create a 
new paragraph, the new paragraph 
will include the same paragraph 
formats, such as alignment, tabs, 
and line spacing.

Heads up

You can also show the Ruler by 
clicking the View Ruler button 
at the top of the vertical scroll bar.

Figure 8–12   
Tab symbols  
and indent 
markers on  
the ruler

◗  Vocabulary
indent

first line indent

hanging indent
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	 Module 2  Key Applications

	 5.	 Click the 5-inch mark on the ruler (just to the left of the Right Indent 

marker). See Figure 8–12. Then drag the Right Indent marker on the 

ruler and position it exactly on top of the Right Tab symbol. The tab 

symbol will appear on top of the Right Indent marker.

	 6.	 Position the insertion point in front of April 11 and press Tab. The date 

is now aligned at the right indent, which was moved to the 5-inch mark 

on the ruler.

	 7.	 Position the insertion point anywhere in line 6. Notice that no tab 

markers show on the ruler, and the Right Indent marker is positioned at 

the 6.5-inch mark on the ruler. The tab and right indent you set in line 5 

was applied to that paragraph only, and that paragraph has only one line 

of text.

	 8.	 Select all of the text in lines 5 through 24. Be sure to include the para-

graph symbol at the end of line 24.

	 9.	 Click the tab selector until the Decimal Tab symbol shows , and then 

click the 3-inch mark on the ruler. Then, remove the symbol from the 

ruler by dragging it off.

	10.	 With lines 5 through 24 still selected, click the tab selector until the 

Right Tab symbol shows, and then click the 5-inch mark on the ruler. 

Click and drag the Right Indent marker to the 5-inch mark on the ruler. 

Insert a tab character in front of the dates in line 9 and 16.

	11.	 Select all of the text in lines 4 through 28. Click and drag the Left 

Indent marker to the 1/2-inch mark on the ruler. Notice that the First 

Line Indent and Hanging Indent markers also move. See Figure 8–13.

Hanging
Indent
marker

First Line
Indent marker

Left
Indent
marker

Margin
marker

	12.	 With lines 4 through 28 still selected, drag the Hanging Indent marker 

to the ¾-inch mark on the ruler. All lines except the first line of each 

paragraph are indented from the left three-quarters of an inch.

	13.	 Deselect the text. Save the changes and close the document.

Figure 8–13 
Left Indent Markers on the ruler

Extra for Experts

If you drag the Left Indent marker, 
the First Line Indent marker also 
moves. When the indent mark-
ers are positioned away from the 
margin markers, you can point to 
the middle of the margin markers;  
a two-headed arrow appears, and 
you can drag to change the margin 
setting.
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Lesson 8  Editing and Formatting Documents	

Adding Bullets and Numbers
Bullets are used to list items when order does not matter—an unordered list. 
Numbered lists are used to identify steps that should be completed in a specific order, 
which are often referred to as an ordered list. Bulleted and numbered lists are auto-
matically formatted with a hanging indent. Word automatically calculates the best 
distance for the hanging indent. You can change the bullet symbol, the number style, 
or the distance for the hanging indent in the Bullets and Numbering dialog box.

Step-by-Step 8.10
	 1.	 Open Step8-10 from the data files, and save the document as 

Exhibition1.

	 2.	 Select the list of eight items under the heading that begins Displays and 

Demonstrations. Click the Bullets button  in the Paragraph group on 

the Home tab. Each paragraph in the selection is formatted with a bul-

let symbol. The symbol will vary depending on the symbol last used. If 

necessary, click the Bullet button arrow to show the bullet options and 

select one of the bullet symbols.

	 3.	 Select the list of four items below the next heading that begins A Look 

at... and click the Repeat button on the Quick Access Toolbar. The last 

action (formatting bullets) is repeated, and bullets are applied to the 

selected text.

	 4.	 Select the list of seven items below the next heading Seminars and 

Films. Click the Numbering button  in the Paragraph group. The 

number format varies depending on the format last used. If necessary, 

click the Numbering button arrow to show the number format options 

and select the number format 1., 2., 3.

	 5.	 Deselect the text and position the insertion point at the end of the 

last line in the numbered list, 7. Transportation. Press Enter. Word 

automatically formats the next paragraph with the number 8 and a 

hanging indent. Enter Water conservation.

	 6.	 Press Enter, and the next paragraph is formatted for item number 9. 

Click the Numbering button to toggle the option off.

	 7.	 Select the numbered list and click the Bullets button. The numbers are 

converted to bullets.

	 8.	 Save the changes and close the document.
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Applying Document Formats
Document formats are applied to an entire document. These formats include layout 
settings such as margins, page orientation, paper size, and page breaks, and you 
will look at adjusting these settings in this lesson. More document formats will be 
covered in Lesson 16. Most of the document formats can be accessed in the Page 
Setup group on the Page Layout tab, shown in Figure 8–14.

Document
formats

Figure 8–14  The Page Setup group on the Page Layout tab

Changing the Margins and the Page Orientation
The margin and page orientation formats you choose should be based on the purpose 
and content of the document and also on the paper size. If you want more or less 
content to fit on a page, you can modify the margin settings. The margin is the blank 
space around the edges of the page. The default margin settings are 1 inch for top, 
bottom, left, and right margins, but you can easily change those settings.

Portrait orientation formats the content of the document with the short edge 
of the page at the top. This is the default setting. You can change to landscape 
orientation, which formats the content of the document with the long edge of the 
page at the top. Your on-screen document accurately reflects the page orientation 
you choose.

Inserting Page Breaks
When you fill a page with text or graphics, Word begins a new page by automati-
cally inserting a soft page break. You can also break pages manually by inserting a 
manual page break, which forces a page break at a specific location, regardless of 
how much text or graphics are on the page. The location of a soft page break will 
change when you add or delete text so that each page remains completely filled with 
text. A manual page break will remain where you insert it until it is deleted.

In Print Layout, Outline, and Draft views, the page break is indicated with a 
dotted line across the page. In Full Screen Reading view the dotted line does not 
appear, but the pages actually look like separate sheets of paper, so you will clearly 
see where page breaks are located. You may not see any indication of page breaks at 
all in Web Layout view.

◗  Vocabulary
margin

portrait orientation

landscape orientation

soft page break

manual page break
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Lesson 8  Editing and Formatting Documents	

Step-by-Step 8.11
	 1.	 Open the Exhibition1 document from your solution files and save the 

document Exhibition1 as Exhibition2.

	 2.	 Press Ctrl+A to select all the text in the document. In the Font group, 

click the Grow Font button three times. All the selected text increases 

by three increments.

	 3.	 Position the insertion point at the beginning of the third heading, 

Seminars and Films. Click the Page Layout tab, and click the Insert 

Page and Section Breaks button  to show a list of options. 

Under Page Breaks, click Page to add a manual page break.

	 4.	 The paragraph and all of the text below the paragraph now appear on 

page 2 of the document. The nonprinting characters reveal a page 

break, as shown in Figure 8–15. Click the View tab and then, in the 

Zoom group, click the Two Pages button .

Page break

	 5.	 Click the Page Layout tab and then, in the Page Setup group, click the 

Page Size button  to show the page size options. Click an option 

for a paper size smaller than 8.5"×11" and the layout will likely change 

in the document window. Click the Page Size button again, and then 

click Letter 8.5"×11" to return to the default setting. 

	 6.	 Click the Margins button in the Page Setup group to show the options. 

Click Wide. 

Heads up

The keyboard shortcut for inserting 
a manual page break is Ctrl+Enter.

Figure 8–15 
A manual page break  
in a document
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	 7.	 Click the Page Orientation button in the Page Setup group. Click 

Landscape. The content is now spread out over three pages. Click the 

Undo button.

	 8.	 Select the paragraph containing the page break and press Delete.

	 9.	 Click the Office Button, point to Print, and then click Print Preview.

	10.	 Uncheck the Magnifier option in the Preview group. When this option 

is unchecked, you can position the insertion point in the document in 

the Print Preview window. Scroll up if necessary and edit the date in the 

heading so it reads September 8-10.

	11.	 Click the Margins button and change the setting to Normal.

	12.	 Click the Shrink One Page button   in the Preview group. 

The document will be resized so all the content fits on one page.

	13.	 Click the Close Print Preview button on the Print Preview tab.

	14.	 Save the changes and close the document.

Using Format Painter
When you apply multiple character or paragraph formats to text, and you need to 
repeat those formats throughout the document, you want the formats to be consis-
tent. You can use the Format Painter button to quickly copy the formatting to other 
text and objects. Format Painter will copy and apply font and paragraph formatting 
as well as some basic graphic formatting, such as borders, fills, and shading, which 
you will learn more about in Lesson 16.

Step-by-Step 8.12
	 1.	 Open Step8-12 from the data files and save the document as Garden. If 

necessary, show the nonprinting characters.

	 2.	 Format the first subheading Creating an “Attractive” Garden as follows: 

Arial font, 11 point, bold, and underlined with a single line.

	 3.	 With the first subheading text selected, including the paragraph marker, 

click the Format Painter button  in the Clipboard group. The mouse 

pointer changes to show a paintbrush when positioned over text.

Heads up

You can also change margins by 
dragging the margin markers on 
the ruler.

◗  Vocabulary
Format Painter

Heads up

You can use Format Painter to 
copy formats from one Word docu-
ment to another Word document.
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	 4.	 Click the first word in the second subheading Tips for Attracting 

Butterflies and Hummingbirds. The formats are applied only to the one 

word. Also, the mouse pointer no longer displays a paintbrush, so you 

cannot continue copying the formats.

	 5.	 Select the first subheading text again, and this time double-click the 

Format Painter button. The mouse pointer changes to show a paint-

brush, and because you double-clicked the Format Painter button, you 

now have unlimited opportunities to copy the formats.

	 6.	 Click and drag the mouse pointer to select all of the text of the second 

subheading. The copied formats will be applied to all of the selected 

text. Click and drag the mouse pointer to select all of the text of the 

third subheading, Modifying an Existing Garden. Click the Format 

Painter button to turn off Format Painter.

	 7.	 Select the first two paragraphs under the title. Justify the alignment of 

text. Change the line spacing to 1.5 lines, and format the font as Arial, 

10 point. Add space before the paragraphs. With the paragraphs still 

selected, double-click the Format Painter button.

	 8.	 Click and drag the mouse pointer over all of the paragraphs below each 

of the three subheadings, but do not drag across the bulleted and num-

bered lists. The paragraphs should now be justified with 1.5 line spacing 

and extra spacing before the paragraphs, and the characters should be 

Arial font, 10 point. Press Escape to turn off the Format Painter.

	 9.	 Notice that the formatting changes have made the document more than 

one page, and Word automatically added a soft page break.

	10.	 Save the changes and close the document.

Finding and Replacing Text
Scrolling through a long document to locate a specific section of text is time con-
suming. The Find command makes locating text and/or formats easier and more effi-
cient. You can use the Find command to search a document for every occurrence of a 
word or phrase or for character and paragraph formats.

When you need to replace or reformat multiple occurrences of the same text, 
you can use the Replace command. The replacements can be made individually, or 
all occurrences can be replaced at once.

Heads up

To turn off the Format Painter 
without applying the format to 
other text, click the Format Painter 
button again or press Escape.
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Step-by-Step 8.13
	 1.	 Open Step8-13 from the data files and save the document as Workout. 

If necessary, position the insertion point at the beginning of the 

document.

	 2.	 In the Editing group, click the Find button . The Find tab in 

the Find and Replace dialog box, shown in Figure 13–16, opens.

	 3.	 In the Find what text box, enter training, and then click Find Next in 

the dialog box. The search begins at the location of the insertion point. 

Word locates and selects the first occurrence of the search text training. 

The dialog box remains open.

	 4.	 Click Find Next again. Word finds the next occurrence of the search text 

in the open document. Click Cancel to close the dialog box.

	 5.	 Press and hold Shift and press F4. The next occurrence of training is 

selected. When you use the Shift+F4 key combination, Word repeats 

the last search. This shortcut is convenient because you can continue 

searching the same word without leaving the Find and Replace dialog 

box open.

	 6.	 Position the insertion point at the beginning of the document. Click the 

Replace button  on the Home tab. The Replace tab in the Find 

and Replace dialog box appears. Click the More button for more options, 

as shown in Figure 8–17. Notice the word training from your last search 

still appears in the Find what text box.

Figure 8–16 
The Find tab in the Find 
and Replace dialog box

Heads up

If you want to search only a spe-
cific portion of a document, you 
can select the desired text before 
beginning the search.
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Click for
format
options

	 7.	 In the Find what text box, enter work out to replace training. With the 

insertion point still in the Find what box, click the Format button in the 

dialog box, and then click Font to show the Find Font dialog box, shown 

in Figure 8–18.

Click to apply
bold and
italic formats

	 8.	 Under Font style, click Bold, and then click OK. Notice that Font: Bold 

appears under the Find what box on the Replace tab. Word will now 

search for all occurrences of work out with the bold format.

Heads up

The keyboard shortcuts to execute 
the Find command are Ctrl+F. 
Use Ctrl+H to execute the Replace 
command.

Figure 8–18 
The Find Font dialog box

Figure 8–17 
The Replace tab in the Find and 
Replace dialog box with more 
options
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	 9.	 In the Replace with box, enter workout. With the insertion point still in 

the Replace with box, click the Format button and click Font. In the 

Replace Font dialog box, click Bold Italic, and then click OK. The search 

text will be replaced with the new text formatted bold and italic.

	10.	 Click Find Next in the dialog box. The first occurrence of the bold 

text work out is selected. Click Find Next again. No replacements are 

made in the document, and the next occurrence of the search text is 

selected.

	11.	 Click Replace in the dialog box. The selected text is replaced with 

workout, formatted bold and italic, and the next occurrence of work out 

is selected.

	12.	 Click Replace All in the dialog box. Word replaces all occurrences of the 

search text with the replacement text. A message box opens indicating 

that three replacements were made. Click OK to close the message box.

	13.	 Position the insertion point in the Find what box and click No Formatting 

at the bottom of the Find and Replace dialog box. Position the insertion 

point in the Replace with box and click No Formatting to remove the for-

mats. Click Find Next once to complete a search without formats. This 

clears the format settings from the Find what and Replace with boxes so 

your next search does not include formats. Click Yes in the message box 

and then close the dialog box.

	14.	 Click Less to hide the options in the dialog box, and then close the dia-

log box. Save the changes and then close the document.
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In this lesson, you learned:

n	 When you add new text in Insert mode, the new characters 
are inserted between existing text. When text is entered in 
Overtype mode, the new text replaces existing text.

n	 The Undo, Redo, and Repeat commands make editing easy 
when you make mistakes, change your mind, or repeat actions.

n	 Selected text can be copied or moved from one location in a 
Word document to a new location in the same document, to 
a different Word document, or to another application. Drag-
and-drop editing is especially helpful when you are moving or 
copying text short distances.

n	 When you use the Cut, Copy, and Paste commands, Word 
stores the selected text on the Clipboard, which stores up to  
24 items.

n	 Word checks spelling and grammar as you enter text.

n	 Formatting a paragraph for left, center, right, or justified 
alignment positions the text appropriately between the left and 
right margins.

n	 You can use the ruler to format tabs and indents.

n	 The Bullets and Numbering feature automatically adds and 
formats bullets and numbers in lists.

n	 The page orientation determines how the document is printed 
on the page. Adjusting the margins affects the blank space 
around the edges of the page.

n	 The Find command makes searching for text easy and efficient. 
The Replace command replaces multiple occurrences of search 
text automatically.

  Vocabulary Review
Define the following terms:

alignment
Clipboard
drag-and-drop editing
edit
first line indent
font
format

Format Painter
hanging indent
indent
Insert mode
landscape orientation
manual line break
manual page break

margin
Overtype mode
points
portrait orientation
select
soft page break

 Rev iew Questions

TRUE / FALSE
Circle T if the statement is true or F if the statement is false.

T	 F	 1.	 You can make several font changes at the same time by using the Font dialog box.

T	 F	 2.	 You cannot edit a document while viewing the document in Print Preview.

T	 F	 3.	 Word defines a paragraph as any amount of text that ends with a paragraph marker.

T	 F	 4.	 If you hold down Ctrl as you drag and drop text, the selected text will be copied instead of moved.

T	 F	 5.	 Portrait orientation is the default setting for Word documents.

SUMMARY
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MULTIPLE CHOICE
Select the best response for the following statements.

	 1.	 A  makes a long document with several paragraphs easier to read, because the reader can easily tell where a new 
paragraph begins.

A.	 first line indent	 C.	 paragraph marker

B.	 hanging indent	 D.	 line number

	 2.	  orientation formats the content of the document with the long edge of the page at the top.

A.	 Horizontal	 C.	 Portrait

B.	 Landscape	 D.	 Layout

	 3.	  refers to how text is positioned between the left and right margins.

A.	 Line format	 C.	 Line adjustment

B.	 Alignment	 D.	 Line spacing

	 4.	 A(n)  is the space inserted between the margin and the line of text.

A.	 first line indent	 C.	 hanging indent

B.	 indent	 D.	 manual line break

	 5.	 Bulleted and numbered lists are automatically formatted using a  indent.

A.	 left	 C.	 first line

B.	 right	 D.	 hanging

Fill In the blank
Complete the following sentences by writing the correct word or words in the blanks provided.

	 1.	 When you use the Copy or Cut commands, the selected text is stored on the .

	 2.	 In  mode, new text is inserted between existing text.

	 3.	 The size of the font is measured in .

	 4.	 Word automatically inserts a(n)  when a page is full.

	 5.	 The  is the blank space around the edges of a page.

  Projects

PROJECT 8–1
	 1.	 Open Project8-1 from the data files. Save the document as 

Languages. If necessary, show nonprinting characters.

	 2.	 Scroll down the page and notice that there is a course 
title separated from its description. Cut the Japanese for 
Beginners title from its current location and paste it above the 
course description that begins Build a solid foundation for 
communicating in Japanese.

	 3.	 Remove the extra blank line that remains above the English as 
a Second Language heading after you moved the Japanese for 
Beginners heading.

	 4.	 According to the director’s notes, Spanish for Beginners and 
Japanese for Beginners are offered on the same day and time 
and for the same number of weeks. You need to add informa-
tion to both class descriptions.
a.	� Copy the class dates, September 25–November 13, that 

appear below the Japanese instructor’s name. Do not 
include the paragraph marker at the end of the dates in the 
selection.

b.	� Position the insertion point below the Spanish instructor’s 
name and paste the dates. Press Enter to insert a blank line 
below the dates.
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c.	� Position the insertion point after the Spanish instructor’s 
name, Ken Grazzi, and press Enter to insert a new line. 
Enter Tuesday, 6-8 p.m..

d.	� Position the insertion point after the Japanese instructor’s 
name, Hiroki Sasaki, and use the Repeat command. Word 
should move to a new line and insert the same day and time 
you entered for the Spanish class.

	 5.	 Show the Clipboard task pane, and clear all the items from 
the Clipboard. Copy to the clipboard the name of the German 
for Beginners instructor and the fee for the German for 
Beginners class.

	 6.	 Paste the German instructor’s name after the course number 
for Continuing German for Beginners.

	 7.	 All classes have the same fee, so you can paste the class fee 
after the dates for each class.

	 8.	 The director’s notes indicate that Ken Grazzi may not be able 
to teach the Spanish class. Delete his name.

	 9.	 You just received an e-mail from the director, and you learn 
that Mr. Grazzi will be able to teach the class after all. Use 
Undo to restore his name.

10.	 Using cut and paste and/or drag-and-drop editing, reorganize 
the information so that the classes are listed alphabetically by 
class title.

11.	 Hide the Clipboard task pane, save the changes, and close the 
document.

PROJECT 8–2
	 1.	 Open Project8-2 from the data files. Save the document as 

Oak Creek.

	 2.	 Change the page orientation to landscape. Change the top and 
bottom margins to 1 inch, and the left and right margins to  
2 inches.

	 3.	 Center the first eight lines of text, beginning with Oak Creek 
Recreation Commission and ending with Mt. Washington 
Recreation Center.

	 4.	 Format the centered text as follows:
a.	� Change the font style of the first line (Oak Creek Recreation 

Center) to bold and the font size to 28 points.
b.	� Change the size of the next two lines (Community Center 

and Program Guide) to 20 points.
c.	� Change the size of the next line (Fall) to 20 points and 

apply bold style.
d.	 Change the size of the last four centered lines to 20 points.

	 5.	 Position the insertion point in front of the word Contents and 
insert a page break. On the new page, format the word Contents 
as 20 point bold.

	 6.	 Select all of the text below the Contents heading and then set a 
right tab at the 6.5-inch mark on the ruler. Format the program 
listings as follows:
a.	� Apply bold and italic formatting to the first three lines of text 

below the Contents heading (Registration, Memberships, 
and Hours) and the last two lines of text (Special Events 
and Community Meetings). Change the size of these lines to 
12 points and the font to Arial. Include the page numbers in 
all formatting changes.

b.	� Apply bold and underline formatting to the head-
ings (including the page number) for each age group 
(ELEMENTARY PROGRAMS, TEEN PROGRAMS, and 
ADULT PROGRAMS). Change the size of these headings to 
12 points and the font to Arial.

c.	� Apply a 0.25-inch left indent to the lists of programs under 
each age group heading and change their size to 12 points.

	 7.	 View the document in Print Preview. You decide that the first 
page could be spread out a little to fill up more of the page. 
Add blank lines as desired to improve the look of the first page. 
Close Print Preview.

	 8.	 If necessary, delete blank paragraphs at the end of the docu-
ment, or adjust the document margins, to fit all the content on 
two pages.

	 9.	 Save your changes and close the document.
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  TEAMWORK PROJECT

  Critical Thinking

Activity 8–1
You have been copying multiple items to the Clipboard. You learned 
in this lesson that the Clipboard holds up to 24 items. What do you 
think happens when you copy a 25th item? Use the Help feature to 
see if your answer was correct.

Activity 8–2
If you completed Project 8-2, you had to add blank lines to center 
the text vertically on the first page of the document. There is another 
way to center text vertically. Use Word’s Help feature to find out 
how to do this. Using Word, write a brief explanation of the steps 
you need to take. What would happen to the second page of the Oak 
Creek document if you follow these steps? Describe at least two 
other types of documents in which you could use this feature.

 ONLIN E DISCOVERY

The fonts you use to format a document can be divided into two 
types: serif and sans serif. Serif faces are often used for the main 
body of a document, and sans serif faces are used for headings and 
other display items. Learn more about the differences between these 
two types of typefaces with a partner.

	 1.	 With your partner, decide who will research serif typefaces and 
who will research sans serif typefaces.

	 2.	 Use the Web, an online encyclopedia, or other references to read 
about typography, the art of designing typefaces. Concentrate 
on your chosen typeface, either serif or sans serif.

	 3.	 You and your partner should be able to answer these questions 
after your research:

a.	 What is a serif?

		  b.	� What is the main difference between a serif typeface and a 
sans serif typeface?

	 4.	 Select a paragraph of text and a heading from any source and 
enter the material using the type of typeface you have been 
studying (you use serif, for example, and your partner uses 
sans serif). Copy the text several times and apply different 
fonts of either serif or sans serif to each copy.

	 5.	 With your partner, decide which of the fonts is most readable 
and appropriate for each type of text.

Selecting and copying text on a Web page is very similar to select-
ing and copying text in a Word document. Open a Web page that 
shows an article with several paragraphs of text. Refer to Table 8–1, 
and test all the select text options listed in the table, noting whether 
each option works or doesn’t work in a Web page. Then, open a new 

blank Word document and test copying text from the Web page and 
pasting the selected test into the Word document. Write a brief sum-
mary describing what is similar when selecting and copying text in 
Word and in Web pages.
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